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 SONAR Update 2017.07 
 
 

The following highlights apply to the Artist, Professional, and Platinum versions. For more 
information on these features, see the related pages. 
 

¶ Bus Pane Aim Assist – Aim Assist has always been available in the Clips pane but not in 

the Bus pane. As the next step after making Aim Assist available in the PRV’s Controller 

pane so that data from the Controller pane can be lined up easily to the notes in the 

Piano Roll view, now you can line up automation in the Bus pane to automation or clips 

in the Clips pane. 

¶ Recently Used Plug-Ins – SONAR now keeps track of the five most recently used audio 

effects and virtual instruments plug-ins. This is not project specific, nor is it dependent 

on the current layout, so new projects will be able to take advantage of having the last 

five plug-ins readily accessible. This also means that users who prefer their own plug-in 

layouts will no longer have to configure layouts for the most commonly used audio 

effects or virtual instruments. 

¶ MIDI Ripple Editing Improvements – Ripple editing has evolved to work better now 

with MIDI as well as audio data, and now prevents notes from getting deleted or 

truncated unexpectedly in some ripple edit operations. Also, MIDI clips are no longer 

split in some situations to help preserve clips that contain long notes. 

¶ Clip Edit Speed Improvements – In projects with a large number of split clips, SONAR’s 

graphical performance could slow down depending on the machine. The 2017.07 

update improves split clip handling so that you can perform tasks like splitting clips at 

transients, or copy and paste loops hundreds of times, without any loss of performance. 

¶ Fixes and Enhancements – and of course, SONAR just keeps getting better. 

  
 
INSTALLING THE 2017.07 UPDATE 
 
Open the Cakewalk Command Center. If you are prompted to download a newer 
version, please follow the on-screen instructions to download it. 
 
To download the SONAR 2017.07 core update, download from the core SONAR Artist, 
Professional, or Platinum category. Professional and Platinum owners should also update 
the Engineering FX Suite if they haven’t yet updated the Adaptive Limiter to version 
1.0.5, which offers fixes and enhancements. 
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 Bus Pane Aim Assist 
 

Artist, Professional, and Platinum 
 
Aim Assist draws a 
vertical line in the 
Track or Piano Roll 
Views at the horizontal 
mouse cursor position. 
This makes it easy to 
align clips, 
automation, 
transients, and the like 
that are on different 
tracks or separated by 
a substantial vertical 
distance.  
 
You can turn Aim 
Assist on or off with 
the keyboard shortcut 
X, or by choosing Edit 
> Aim Assist. 
 
In the 2017.06 update, 
the PRV added the 
ability for Aim Assist to 
extend into the 
Controller Pane. In this 
update, Aim Assist can 
now extend into the 
Bus Pane. In the 
screen shot on the 
left, note that the Aim 
Assist line is lining up a 
drop in reverb to the 
start of a drum pattern 
in Track 1. 

 
Note that you can customize the Aim Assist color. Choose Edit > Preferences > Customization – 
Colors and then in the Color Category list, select Track View. In the Screen Element list, select 
Aim Assist line. After you specify the desired color, click OK to close the Preferences dialog box.  
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 Recently Used Plug-Ins 
 

Artist, Professional, and Platinum 
 
SONAR now remembers the five most recently used audio effects and virtual instrument plug-
ins. Because this isn’t project-specific, you can take advantage of this feature when working 
within any project, or starting a new project. 
 
The five effects or instruments appear at the top of the list of effects or instruments 
respectively. In this example, the Objeq Delay from A|A|S is being added to a guitar track. 
 

 
 
 

For Advanced Users 
 
Advanced users can modify this list through the Registry, which stores the IDs of the most 
recently used plug-ins. That way if plug-ins you use rarely are used extensively on a particular 
project (e.g., restoration tools for a tough project), you can clear the list when you’re done with 
the project. Please note this is recommended only for extremely advanced users who have 
first backed up their registry—mistakes in editing the registry can kill your system. The Registry 
tree for effects is: 
 
HKEY_CURRENT_USER\Software\Cakewalk Music Software\SONAR\(Version)\Recently Used 
Plug-ins 
 
For virtual instruments: 
 
HKEY_CURRENT_USER\Software\Cakewalk Music Software\SONAR\(Version)\Recently Used 
Synths 
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 Clip Edit Speed Improvements 
 
Artist, Professional, and Platinum 
 
In projects with thousands of clips, SONAR’s 
performance can become slower if the machine 
can’t handle the amount of graphics being 
displayed. Starting with this update, users can 
perform tasks like split multiple clips at 
transients, or copy and paste loops hundreds of 
times, and continue to work in the project 
without interruptions. These improvements 
also affect operations such as split, move, undo, 
redo, ripple edit, as well as zooming and 
scrolling in projects with many crossfades. Undo 
of splitting AudioSnap beats is also much faster, 
and memory usage has been reduced by 75%. 
 
The benchmarks to the right compare 
differences between the 2016.06 and 2016.07 
releases when doing operations with a project 
that contains 15,941 events (see below).  
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 MIDI Ripple Editing Improvements 
 
Artist, Professional, and Platinum 
 
Compared to audio data, Ripple Editing is much more complex with MIDI data—but with the 
2017.07 release, MIDI data joins the ripple editing club. Just remember one of the cardinal rules 
of ripple editing: turn it on before doing the edit (choose Options > Ripple Edit Selection or 
Options > Ripple Edit All), and turn it off after the edit so you don’t move clips around 
inadvertently. 
 
Here are some examples of how ripple editing affects MIDI notes with Ripple All selected. 
 
 
USE CASE #1 
 
The clip marked in red is about to be deleted. Note the selection in the timeline that 
encompasses measure 6. 

 
 
With Ripple Editing Select All, deleting this clip deletes everything in measure 6, so clips that 
started at measure 7 shift over to the left to start at measure 6. Note that because cutting 
deletes the start of the MIDI note (colored yellow for clarity), there is no note-on and therefore, 
cutting removes the note. 
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USE CASE #2 
 
In this example, measure 7 has been selected in the timeline and the clip in red is about to be 
cut. Note the length of the MIDI note highlighted in yellow. 

 
With measure 7 cut, what started at measure 8 now shifts left to measure 7 to fill in the hole. 
Because the MIDI note’s note-on event is not included in the cut, the MIDI note simply 
becomes shorter. The note would also have been shortened if measure 8 had been cut. 
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USE CASE #3 
 
The clip highlighted in red is about to be deleted. Note that two MIDI notes are within this 
region—the end of one long MIDI note, and a note-on event for a second MIDI note. 
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Cutting deletes the part of the first MIDI note that’s contained within measure 9, thus 
shortening it. This also deletes the second note (highlighted in yellow) because its note-on 
event falls within the region being cut. The audio in measure 11 now starts at measure 10. 
  

 
 
 
USE CASE #4 
 
The timeline is selecting measure 11, and the clip highlighted in red is about to be deleted. Note 
the length of the MIDI note highlighted in yellow. 
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After cutting, all the clips in measure are deleted. However because the MIDI note started 
before measure 11 and extended past measure 11, it’s simply shortened. 

 
 
USE CASE #5 
 
Measure 9 is selected in the timeline, and the clip highlighted in red is ready to be moved one 
measure to the right. Note the positions of the MIDI notes highlighted in light blue and yellow. 
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The material that started at measure 9 now starts at measure 11. The yellow MIDI note’s note-
on was within measure 9, so the note moves along with the other clips. The MIDI note 
highlighted in blue remains unchanged because there was no cut (moving the MIDI note’s end 
would create a new, and likely unwanted, MIDI note fragment with a note-on in measure 11). 

 
USE CASE #6 
 
Measure 11 is selected in the timeline, and the clip highlighted in red is going to be moved two 
measures to the right.
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The material that started at measure 11 now starts at measure 13. The MIDI note highlighted in 
yellow remains unchanged, because its note-on event was not included in measure 11. 

 
 
  



 
 

15 

 Fixes and Enhancements 
 
Artist, Professional, and Platinum 
 
General 
¶ Using SONAR with a 64-sample buffer size could cause issues if 64-bit Double Precision 

was enabled for the audio engine 
¶ The Track View In-line Piano Roll and Piano Roll View now have consistent behavior 

when thinning grid lines during zoom in/out 
¶ Resolved a possible crash when using two-finger touch scrolling on the track pane 
¶ Editing operations (split, move, undo, redo, and ripple edit) in large projects are now 

approximately 10x faster  
¶ Zooming and scrolling in projects with many clips and crossfades is now considerably 

more responsive 
 

AudioSnap 
¶ Using AudioSnap to Split Beats could previously cause SONAR to become unresponsive 

when trying to display all the split clips 
¶ Memory usage with AudioSnap has been reduced by 75% when using it to Split Beats 

without editing the transient markers 
 

Browser 
¶ Dragging plug-ins from the Plug-in Browser no longer collapses Browser folders after 

inserting the plug-in into the project 
 

Ripple Editing 
¶ Please see the section on MIDI Ripple Editing Improvements for more information. 
¶ MIDI events will now be shortened or lengthened when Ripple Editing if the end of a 

note is selected or the selection is in the middle of a note. This prevents notes from 
getting deleted or truncated unexpectedly in some situations during a ripple edit.  

¶ MIDI clips are no longer split in some situations. This is to help preserve clips that 
contain long notes. 

 
Snap Module 
¶ Disabling Snap previously created problems with showing triplets and dotted settings. 

These buttons will now stay lit to better indicate what Grid Lines are being displayed 
when Snap is Off. 

¶ Snap settings could change unexpectedly if they were altered when Snap was Off 
¶ The Control Bar’s Smart Grid option is no longer disabled upon cancelling out of the 

menu 

Staff View 
¶ Arrow keys now change track selection in the Track Pane of the Staff View 
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Step Sequencer 
¶ Click + Dragging in the Step Sequencer could cause SONAR’s UI to stop updating 

momentarily until releasing the mouse button 
 
Track View 
¶ Aim Assist now feels more responsive and moves smoothly in the Track View 
¶ Resolved an issue where copy and paste with lanes closed could result in overlaps on 

the same lane 
¶ Track View Grid wouldn’t update after changing the snap settings 
¶ Track View wouldn’t always follow (non-smart) grid line settings in the Snap Control Bar 

module 
¶ The Time Ruler no longer shows additional ticks when set to Smart Grid. This now 

displays the only the Beat markers. 
¶ The Track View In-line Piano Roll didn’t follow snap setting in some situations 
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 Review of the Month 1: SampleTekk Classic Grand Piano 
 

By Craig Anderton 
 
 

SampleTekk is no stranger to sampling grand and upright pianos, having produced 35 piano 
sample sets over the years not just for use with programs like Native Instruments’ Kontakt, but 
also for Nord, Steinberg, Toontrack and others. The Classic Grand Piano expansion pack brings 
SampleTekk’s pianos to Rapture Pro and Rapture Session. There are 27 main programs, but 81 
total because there are three variations on each one. These variations are in three categories: 
Classic Grand, Classic Grand Bright, and Classic Grand Soft. Over 1,100 samples and 16 velocity 
levels are responsible for the responsiveness; there’s a sound demo on YouTube.   
 

 
This collection is all about the sampled piano, and about providing lots of useful sounds that are 
“plug and play”—just call up a program, and start hitting those keys. 
 
 
THE GANG OF FOUR 
 
Each program includes four Instrument controls, as well as X/Y Pad 1 assignments. The X/Y Pad 
1 X-Axis controls distortion, however note that the maximum value provides the least distorted 
sound, while the minimum value grunges things up. The Y-Axis controls a 6-pole Highpass filter, 
which is enabled for all Elements in all programs. The maximum value takes the Highpass filter 
out of the picture, while lower values reduce low frequencies. So if you’ve done MIDI Learn for 
the X/Y pad in order to tie the parameters to CC #1, you’ll want to do a MIDI Forget because 
having the mod wheel set to 0 produces a thin, distorted sound—which is not what these 
pianos are about. 
 

https://youtu.be/CdJbZk8oG3w
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You’ll want to keep the four instrument controls at relatively low levels, because they’re 
designed to add sonic artifacts. However they are effective at giving a “real piano” vibe, just like 
adding slides to bass samples or finger squeaks to guitar. Here’s the story on the four controls. 
 
 

  
¶ Hammerback. This is the sound the piano hammers make when they fall back after 

hitting the strings. 

¶ Pedal. Pedals make noise, so for extra realism you can add in a pedal sound that plays 

whenever the CC #64 changes state (note that it doesn’t respond to other pedals, i.e., 

CC #66 for sostenuto or CC #67 for soft). 

¶ Ambience. This parameter does what you’d expect—it adds a degree of ambience to 

the sound. 

¶ Resonance. When sustain is occurring, this adds string resonance that makes the sound 

bigger and more authentic. 

 
 
CHECKING OUT THE SOUNDS  
 

When auditioning the sounds, the most basic versions (and therefore most suitable for custom 
processing or “real” piano sounds) are at the end of the program list. The other 26 presets have 
varying degrees of processing, “hardness,” and so on. 27 programs is a manageable number—
it’s easier to remember which ones have sounds you want to use—and then if you want a softer 
or brighter sound, you can use the same sound from one of the other appropriate categories. 
 
I assume most people will wonder “are these better than the pianos that come with Rapture 
Session/Pro’s stock factory programs?” The answer is yes, because the stock programs are 
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more special-purpose, while the SampleTekk ones are suitable for a wide variety of musical 
applications, and the samples themselves have more presence and accuracy. 
 
As to comparisons with other libraries, piano samples are always controversial for what I think 
are two main reasons. First, no piano sound that depends on speakers or headphones will ever 
give the same visceral experience as a real piano, where hundreds of strings vibrate real wood. 
Second, pianos have very different characters. Two pianos can be sampled superbly, but one 
can appeal to you while another doesn’t.  
 
There are a lot of sampled piano libraries (if you go to Native Instruments’ site, you’ll find 35 
different piano packages for Kontakt alone). Prices are all over the place as well—there are 
some pretty great piano sample packages from Synthogy and East West (which they better be, 
considering the price). Then you have more mid-priced products like Modartt’s Pianoteq 
modeled piano, and XLN Addictive Keys. 
 
The main competition for SampleTekk’s offering is Waves’ Grand Rhapsody piano at $29, so I 
compared that as well as the “lite” True Piano instrument (full version $120) in Platinum, and 
for a taste of a medium-priced library, Alicia’s Keys ($99) for Kontakt.  
 
With SampleTekk vs. Grand Rhapsody, Grand Rhapsody has more control over the sound 
(reverb, EQ, miking, etc.)—clearly, Waves expects it to be used stand-alone was well as a plug-
in—but I find SampleTekk has a richer, more developed sound that fits into a variety of musical 
applications, not just pop. Add some ProChannel EQ after it, and you can really shape the 
timbre. Also, the Classic Grand Piano is laptop-friendly; the FLAC files are about a 200 MB 
download, but the samples expand to 1.4 GB when loaded into Rapture Pro/Session. Grand 
Rhapsody has a 14 GB and a 6 GB version, but the extra space doesn’t make much difference in 
the resulting sound. 
 
Compared to pianos in the $100 price range, the extra money gets what sounds to me like a 
more natural-sounding sustain compared to either Concert Grand Piano or Grand Rhapsody. 
The difference is subtle, and you’ll notice it only if letting the notes ring out; under most 
circumstances, it won’t make much difference. 
 
 
CONCLUSIONS 
 
The Classic Grand Piano has only two limitations I could find. The first is that it doesn’t take full 
advantage of being a Rapture-based instrument. I believe the X/Y pad would be far more useful 
as treble and bass controls for tone-shaping, and the four unused Instrument page knobs could 
provide useful functions—like a fine tuning control, control over the effects (by inserting them 
in the individual Elements instead of as master effects), and maybe distortion for lo-fi and rock 
piano sounds. However, it’s easy to add these mods—see the accompanying article, “DIY 
Sampled Piano Mods.”  
 
The second limitation has an easy workaround. At really high velocities, the keys hit hard and 
while this is accurate, the “clack” can be distracting. The solution is to use Cakewalk’s Velocity 
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MIDI FX to limit maximum velocities to around 120 or so. This doesn’t affect the expressiveness, 
only the timbre at high velocities. 
 
My “go-to” pianos have been the TruePianos Amber in Platinum and Alicia’s Keys for Kontakt. 
However, Classic Grand Piano provides a warm, rich character that’s different from those two, 
and it’s a very welcome addition. For Artist and Professional owners (these versions don’t 
include TruePiano Amber), Classic Grand Piano gives an expressive, responsive, rich piano 
sound for under $40 (I also consider it worth the extra $10 compared to Grand Rhapsody). 
 
SONAR Platinum owners may find Classic Grand Piano superfluous because TruePianos Amber 
fulfills many piano needs, and you can process its sound further within SONAR. However even if 
you’re happy with your piano library, Classic Grand Piano will expand your sonic options at an 
extremely cost-effective price.  
 
 
 

NOW AVAILABLE IN THE CAKEWALK STORE 
 
SampleTekk’s Classic Grand Piano is available as a download in the Cakewalk Store for $39.99. 
 

  

http://store.cakewalk.com/store/cakewalk/list/categoryID.4826873500
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 Review of the Month 2: Digital Sound Factory B3 Tone Wheel Organ 
 

By Craig Anderton 
 
 

There are some really good hardware “clonewheel” instruments, which finally produce sounds 
that liberate roadies from the agony of carrying around tonewheel organs with rotating speaker 
cabinets. But there’s more to life than hardware—and when you want to go virtual, there are 
plenty of choices. DSF’s B3 expansion pack for Rapture, the subject of this review, is an 
unusually useful set of sounds that go well beyond the Rapture factory programs. 
 
There are 50 programs featuring various drawbar settings and rotating speaker sounds, all of 
which are very well-sampled and feel “right” (there are 1,148 samples, with 44.1/16-bit 
resolution). An additional 18 “groove” programs take advantage of Rapture’s modulation and 
step sequencing options to provide sounds that can kickstart songwriting, or perhaps fit into 
dance music when you want “old school” sounds with a modern vibe. 
 

THE INSTRUMENT PAGES 
 
So…the sampling is spot-on, and the price is right. But what adds real value to this package is 
the Instrument page programming for the eight controls. The controls for the various pages are 
not all the same, but optimized for the different programs. Some give additional control over 
the rotating speaker parameters, others add overdrive or effects, some alter the mix of the 
drawbars, and so on. This is in addition to having the mod wheel alter the rotating speaker 
speed. As a result, even though there’s already an extensive collection of programs, these 
tweaks let you customize the sounds even further for particular applications. 
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The X/Y Pad does panning, but oddly, with some programs moving the crosshair to the left pans 
right and vice-versa. If this bothers you, the fix is easy: Click the Mixer Edit tab, then Mod 
Matrix, and change the X/Y Pad’s Pan All parameter from -100 to 100 prior to re-saving the 
program. Finally, some might complain about the samples not being 24-bit resolution—but B3’s 
don’t have that kind of resolution anyway. 
 
  
CONCLUSIONS 
 
The B3 sound is a big part of musical history, and a must-have for some musical genres. 
Although there are quite a few good organs in the factory sound packs for Rapture, most are 
ports from Dimension Pro and don’t have Instrument page controls—a major disadvantage 
compared to the DSF B3 Tone Wheel Organ pack, where it’s so much easier to dial in the sound 
you want. It’s also obvious a lot of work and care went into creating this pack; it takes 
advantage of what Rapture Pro does well, and comes across almost like a labor of love—check 
out the YouTube demo video. 
 
Although I don’t use a lot of B3 organ sounds in my own music, I spent enough years on the 
road and in studios to have “that” sound burned into my brain. As far as I’m concerned, the B3 
Tone Wheel Organ Pack provides everything I’ll need for projects that want a B3 sound.  
 
 

NOW AVAILABLE IN THE CAKEWALK STORE 
 
DSF B3 Tone Wheel Organ is available as a download in the Cakewalk Store for $39.99. 
 

 

https://youtu.be/cMOXPcDMtlw
http://store.cakewalk.com/store/cakewalk/list/categoryID.4826873500


 
 

23 

 DIY Sampled Piano Mods 
 
By Craig Anderton 
 
 

I really don’t need another sampled piano…but I checked out the SampleTekk pack for Rapture, 
and I really like its rich, warm character (see the previous review for more info). 
 
However while the samples sound fine, the instrument itself doesn’t really take advantage of 
Rapture Pro’s Instrument page—so let’s add some versatility. And even if you don’t have the 
SampleTekk pianos, the following “mods” apply to other sampled pianos, and also provide 
useful tips on synth programming in general. 
 
 
SOLIDIFY THE FUNDAMENTAL 
 
At one point in my life, I had the unenviable task of fitting a sampled piano into 64K of RAM (no, 
not 64 Megs)—which meant pulling out every trick in the book. In the process, I found a 
“cheat” that can add a subtle enhancement to sampled piano.  
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As luck would have it, Element 6 is unused in the SampleTekk factory patches. We’ll add a low-
level sine wave to reinforce the fundamental. 
 
There are only three edits needed for Element 6: 
 

¶ Load a Sine wave as the waveform 

¶ Create an envelope for the Amp section so that the sine wave decays at a slightly faster 

rate than the decay of the sampled notes 

¶ Set the Amp’s Level parameter to 10 

 
Now let’s tie this to an Instrument page control. Click on Mixer and then the Mod Matrix tab. 
Choose Source = Macro Knob 5, Destination = Volume 6, and Amount = 36. Now Knob 5 on the 
Instrument page can mix in a sine wave “fundamental.” Do so subtly (e.g., turn the knob up to 
about 66.0), and the piano will have more “authority.” 
 
 
ADD A TONE CONTROL 
 
I didn’t find the existing X/Y 
Pad 1 controls all that useful, 
so let’s create better 
distortion elsewhere, and 
turn the X/Y Pad into a bass 
and treble shelving-type 
tone control.  
 
1. Click on Element 1 and 
turn off the power buttons 
for DSP 1 and Filter 1. 
2. Choose the following 
settings for the Element 1 Equalizer:  
 

¶ Band = 1, Type = Lo, Freq = 200, Q = 1.0, Gain = -12 

¶ Band = 3, Type = Hi, Freq = 2000, Q = 1.0, Gain = -12 

 
To tie these to the X/Y Pad 1, click on Mixer and then the Mod Matrix tab. Do the following 
assignments: 
 

¶ Source = X/Y Pad 1X, Destination = Eq1 Gain 1, Amount = 24 

¶ Source = X/Y Pad 1Y, Destination = Eq3 Gain 1, Amount = 24 

 
The “tone controls” are flat when the X/Y Pad crosshair is in the center. Moving it up increases 
treble, down decreases treble, right increases bass, and left decreases bass. 
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DIRTY IT UP! 
 
Distorted piano has its uses, so let’s give these samples some refined distortion. 
 
1. Click on Element 1 and set the drop-down menu for DSP2 (which should have its power 
button enabled) to Rect. 
2. Set Filter 2 to LP2 as the mode, and Cutoff all the way clockwise. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
Now let’s create a distortion control on the Instrument page. Click on Mixer and then the Mod 
Matrix tab. Do the following assignments: 
 

¶ Source = Macro Knob 6, Destination = DSP2 1, Amount = 100 

¶ Source = Macro Knob 6, Destination = F2 Cutoff 1, Amount = -3930 

 
As you turn Knob 6 clockwise, the distortion increases but at the highest settings, the filter pulls 
back a bit on the high frequencies to reduce harshness. 
 
 
RADIATE AND REVERBERATE 
 
You probably have a favorite reverb for SONAR, but if you use Rapture stand-alone, you may 
want some built-in reverb.  
 

 
1. Click on Element 1. 
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2. For the Insert effect, choose Stereo Large Hall and set the controls so Level = 100, Damp = 
16.5, Tone = 1577.5, and Dry/Wet = 0. 
 
Let’s assign the reverb to Knob 8. Click on Mixer and then the Mod Matrix tab. Do the following 
assignment: 
 

¶ Source = Macro Knob 8, Destination = FX Dry/Wet 1, Amount = 55 

 
 
FINE TUNING 

 
A piano with a fine tuning control? Why not—it can come in handy 
for standalone applications, or if you want to layer two pianos and 
offset them slightly.  
 
Make the following changes for Elements 1, 5, and 6 in the Pitch 
section: 
 

¶ Transp = 0, Tune = 0 

 
To assign the reverb to Knob 7, click on Mixer and then the Mod Matrix tab. Do the following 
assignment: 
 

¶ Source = Macro Knob 7, Destination = Pitch All, Amount = 200 

 
With Knob 7 up halfway at 50.0, the piano is at concert tuning. Rotating clockwise or counter-
clockwise will raise or lower the pitch by up to one semitone, respectively.  
 
And there you have it—a modded sampled piano that not only sounds wonderful, but takes 
advantage of what makes Rapture Pro such a fun instrument. 
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 SONAR 101: Understanding Loop Construction   
 
By Craig Anderton 
 
 
When SONAR first appeared, one of its strengths was the ability to create, edit, and save WAV 
files that could stretch automatically with the project tempo and pitch. Previously, this type of 
convenience was pretty much the domain of Sony’s Acid software (originally introduced by 
Sonic Foundry). Although DJs and groove-oriented musicians took to this concept initially, over 
time loops have worked their way into a variety of musical genres, including rock and 
soundtracks. 
 
While many musicians are content to use loops from sample libraries, quite a few create loops 
from their own recorded material. For example, if a guitarist plays a great lick, sometimes it’s 
worth repeating as a motif in different parts of the song. But even if you use commercial loops, 
it’s important to know how to edit them because sadly, a lot of sample CDs are carelessly 
“prepped” and do not stretch well over a wide range of tempos. 
 
SONAR’s Loop Construction window is the center of activity for editing, creating, and saving 
stretchable loops, which SONAR calls “groove clips.” We’ve covered some aspects of looping 
before in The Big Book of SONAR Tips, but let’s cover how to make loops from start to finish. 
 
To make this article as real world as possible, download the example loop. This is a file from my 
AdrenaLinn Guitars sample CD (but with the groove clip characteristics removed), and we’ll use 
it to illustrate the various points in this article.  
 
 
GROOVE CLIP BACKGROUND 
 
A groove clip embeds pitch and tempo information into a standard WAV file’s file header. This 
information instructs SONAR how to play back the file when there are tempo or pitch 
variations. The more accurate and detailed the pitch/tempo information embedded in the file, 
the better the stretching quality during playback. 
 
SONAR’s groove clips are compatible with the “acidized” file format that was introduced in 
Sony’s Acid loop-based composition program; in fact, you can load “acidized” files into SONAR, 
and SONAR “groove clips” into Acid (now owned by Magix). 
 
The underlying technology is DSP-based. The basic process is to create “slices” of audio at 
transients, add or remove samples to lengthen or shorten the loop respectively, then crossfade 
these segments to smooth any transitions within the loop. Some wonder how this differs from 
REX files; the latter applies minimal DSP to the slices, so the audio quality is virtually unaltered. 
However, REX files pretty much require percussive material, because putting slices in the 
middle of a sustained tone produces an audible discontinuity. With DSP, crossfading within a 
sustained tone hides these kinds of problems. 
  

http://store.cakewalk.com/store/cakewalk/pd/productID.5111689600
http://www.craiganderton.com/
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Groove clips have limits to their stretching abilities. Slowing down a loop too much creates 
artifacts, as the algorithms struggle to insert samples that extend the material. Speeding up is 
less problematic, because it’s easier to remove existing material than create new material that 
never existed. This is why loop library designers often record their loops at slower tempos, if 
possible. 
 
 
LOOP CONSTRUCTION PREPARATION 
 
Okay, enough theory. Download the file W_FUNK04_Bb.WAV, bring it into SONAR, and let’s 
turn it into a groove clip.  
 
Double-click on the clip, and the loop construction window opens up. Click on the Loop button 
to enable looping (you can also click on the Clip drop-down menu to turn on looping). 

 
 Click on the loop button to convert the 
clip from a standard WAV file to a 
Groove Clip. 
 
We need to tell SONAR the Clip 
length. After you’ve enabled looping, 
the number of beats appears in the 
“Beats” field (8 in this case), and a 
bunch of “slice markers” (more on this 
later) default to eighth notes. Usually 
SONAR gets the numbers of beats 
right, but you can enter a number in 
the “Beats” field if you need to edit 

this. If it’s incorrect, usually you’ll need 
to divide the number of beats by two. 

 

You can choose the bus over which you want to preview the loop’s audio. 
 

https://1drv.ms/u/s!Am5TdLYuWxQOiQiflBHzJC_h6gh9
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Set the Project tempo in the main program to 100 BPM (the same as the original loop tempo), 
and click on the Loop Construction Window’s Play button (to the left of the Loop button) to 
hear what we have so far. Like the Browser, there’s a drop-down menu for choosing the 
Preview Bus (under the Options tab).  
 
While you’re at it, under Options choose Auto Slice Preview. This lets you hear a slice if you click 
on it in the main waveform view. Enabling Auto Slice Preview Loop causes the selected slice to 
loop; leave it off for now. 
 
 
TWEAKING THE SLICES 
 
When you play the clip (remember to use the Loop Construction window’s Play button, not the 
main Transport button), you’ll hear there are several guitar chords. We want to place a slice 
transient marker at the precise beginning of each chord’s attack, so that each chord lives in its 
own slice. 
 
The drop-down menu below the “Slice” drop-down menu puts slice markers at specific 
intervals. This can save you a lot of time if you’re slicing something like a drum machine pattern 
with a regular 16th note high-hat pattern; just set the slices to 16th notes, and you’re probably 
done. Note that if you set the Threshold value to 0, slices will show up only at the interval you 
specified.  
 
However because this is a guitar part played by a human, we’re going to add slices manually—
which is also more educational when learning how to create loops—so select No Slice from the 
drop-down menu. 

 
There are several 
semi-automatic 
options for placing 
slices within a file, 
but we’ll do some of 
it by hand. 
 
Note that SONAR 
has detected three 
transients – the 
most obvious 
transients in the 
file. These are at 
beats B3, B4, and 
B5. However, there 
are more chords 

being played than 
just that, so change the 
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Threshold parameter to 100%. This makes SONAR more sensitive to transients, and several 
more slice markers show up at these transients. 
 

 
SONAR has now identified more of the individual slices in the loop. 
 
Now click in each slice in the waveform. You’ll note that SONAR has done a pretty good job of 
isolating the chords, except for the slices that fall around Beat 2 and Beat 6. We need to add 
more transient markers for these chords. 
 
Double-click in the markers row 
to add another transient marker 
at B2, and create another slice. 
 
Double-click with the Smart Tool 
in the markers row to add 
another transient marker at B2. 
Markers you add are purple. Now 
let’s add the needed slices 
around Beat 6. 
 
Use the horizontal zoom in 
button (+) so that this slice fills 
most of the Loop Construction 
window. Look closely at the 
waveform. You can pick out what 
appears to be a fairly significant 
“blob” of audio just before B6. 
Double-click as you did previously to add a slice at this transient. 
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Click in the slice to the right of the marker you just added. We still need four more markers to 
mark the five chords that occur within this slice. To fine-tune a marker’s placement, click on its 
triangle and drag to the desired position; continue listening to slices and tweaking markers until 
each chord has its own slice. You’ll end up with slices in the following places. 

The transient around B6 are difficult to see unless you zoom way in. When you locate the 
transients, add another slice marker. 
 
Ideally, you want markers to sit at the precise beginning of a transient. For example, if you 
zoom way in on the marker that was generated around Beat 3, it hits a little bit early. Drag this 
marker to the right so that it sits right at the beginning of the transient that hits on Beat 3. Note 
the triangle turns purple to show that’s been adjusted manually. 
 
Now let’s test our loop. Change the project tempo to 150 BPM, and click on the Loop 
Construction Window’s Play button to preview the loop. It should have the same rhythm as the 
original, only faster. 
 
Change the project tempo to 70 BPM, then preview the loop. This makes the DSP work a lot 
harder, and also reveals a problem: The little decays at the ends of the chords that start at B2, 
B3, and B4 end up getting stretched so they last longer, and therefore sound unnatural. To 
solve this, add another slice marker just before each of the little decays.  
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Note the three slice markers added just before the final decay for the chords at B2, B3, and B4. 
These help create a more realistic sound when slowing down the tempo. 
 
Now play the file at 70 BPM; it sounds much better.  
 
Another problem with slowing down is that sustained sections can sound uneven, because a 
fairly long section is being stretched. We can fix this by adding another slice marker in the 
middle of long sections. For example, when previewing the file at 70 BPM, note how the first 
slice has some “wavering.” Add a slice marker in the middle of this slice, and the wavering goes 
away. Try the same technique with the slice that begins at B5 as well. 
 
You can tweak groove clips forever, but this one works pretty well from about 80 to 180 BPM—
better than a 2:1 tempo ratio. More tweaking won’t improve it by that much. 
 
 
ESTABLISHING THE ROOT PITCH 
 
For melodic loops, enter the original key (the one at which the loop was recorded) in the Pitch 
field. This loop identifies the pitch as Bb in the filename, so set the pitch to A#. 

 
Here’s the “key” to having 
a loop follow any project 
key changes, as set by the 
project pitch value.  
 
Setting pitch should cause 
the loop to follow the 
project pitch, as specified 
under Project > Set 
Default Groove Clip Pitch. 
For example, if the Default 
Groove Clip Pitch is set to 
C, this Bb loop will play 

back at C. 
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If you want to transpose the loop, then enter the 
new pitch by inserting a marker as you would 
normally (e.g., type “M” at the Now Time). You 
don’t have to name this if you just want the 
marker name to reflect the pitch change. 
 
To transpose Groove Clips, insert pitch markers 
in the timeline. 
 

The Loop Properties window offers a variety 
of loop options, including whether or not to 
follow the Project Pitch. 
 
You can choose to have a loop follow the 
project pitch or not (for example, you may 
not want a drum loop to follow pitch). To set 
this, choose Clip > Loop Properties. In the 
Audio Stretching tab, you can check or 
uncheck the “Follow Project Pitch” box, as well 
as fine-tune the loop’s pitch or transpose it. 
 
 
[9¢Ω{ Dh b¦¢{Η 

Changing gain, pan, and pitch on a per-slice basis is can lead to very creative results…as well as 
very twisted ones. 
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What’s more, you can create envelopes to alter gain, pan, and pitch for each slice. This works 
very much like standard envelopes, although changes are quantized to each slice and you can’t 
change values within a slice. In other words, an individual slice can’t fade out or pan from left to 
right—it will be set at a constant level or constant pan position. 
 
The edits can be done graphically; there are three choices from the Slice menu, each of which 
corresponds to show/hide for an envelope (orange for pan, blue for pitch, and light green for 
gain). Drag the envelope within the slice to edit. 
 
While you’re editing, a tooltip shows the amount of gain, pan, or pitch change for the selected 
slice while you’re doing the editing. Pitch changes default to semitone steps, but you can hold 
Shift while editing the pitch envelope for fine-tuning the pitch. There are some limitations to 
using envelopes—gain changes might produce pops if there are significant level shifts—but 
being able to change these parameters allows for tremendous creative latitude. 
 
 
[9¢Ω{ D9¢ {!±95! 
 
You don’t want to do all this tweaking again, right? So save the file by selecting the Clip tab in 
the Loop Construction view, clicking on “Save Loop,” and then navigating to where you want to 
save the loop. Happy looping! 
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 You Mix, We Master 
 

By Craig Anderton 
 
Sometimes you don’t want a full-blown mastering job, but just a better-sounding mix. From 
time to time, we take a reader-submitted song and describe how to master it using SONAR’s 
available tools. This issue’s project is “Roasting on the Stones,” an original song by Bill Saunders. 
However, the thrust of this particular installment is more like “you mix, we remix…” 
 
 
ANALYSIS 
 
Like the other tracks received so far, the song itself is “mastering-friendly”— plenty of 
headroom, with no processing added to the master bus. What’s more, I thought the mix was 
already pretty much where it needed to be. I could quibble with the kick being separated into 
the right and left channels—I’m one of those “mix in the center” traditionalists—but overall, 
there was a good frequency balance. 
 

I did feel the song lacked some lower midrange “meat.” Many times there’s a midrange buildup 
that I need to cut a bit, but boosting the lower mids somewhat put the bass and high-frequency 
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sheen into better perspective. Although I realize that reggae-based music tends to be a bit bass-
heavy, I don’t think that’s diminished by the midrange EQ. 
 

I also added some A-Type Console Emulator and hit the Drive pretty 
hard. Normally this is something where I’d consult with the client, 
but the song had a little hint of roughness and I wanted to 
accentuate this a bit. 
 
The only other processing was adding some Adaptive Limiter to the 
stereo master. Now, of course someone will write in the 
“comments” section that limiting is bad. Well, it kind of is…but the 
reality is that it’s a singles world, songs end up on playlists, and 
without at least some dynamic range squashing the song will sound 
weak by comparison. Again, this is something where I normally work 
with the client to determine what degree of squashing they want, 
but given the circumstances I just used a “default” type of dynamics 
processing. 

 
But what I really heard was that the song needed a little more variety from beginning to end—
just enough to give the listener an occasional surprise. So, this started to look more like a “light 
remix” project than straight-ahead mastering. 
 
Now, whether a mastering engineer starts making creative decisions like this or not depends on 
the mastering engineer and the client. I’m the kind of engineer who likes a lot of interaction 
with an artist, and seek approval at every step along the way if I’m going to make any kind of 

substantive changes. 
In this case, though, 
I did what I felt like 
doing because I 
thought it would 
make for a more 
interesting 
article…and hoped 
Bill would be okay 
with it. 
 
 
REMIX TIME 
 
I didn’t want to take 
this into dub 
territory, but a little 
echo never 
hurts…right? So, I 

set up the ever-popular Sonitus delay in a bus, and created send automation so that only 
specific parts of the song would be echoed. Here are the echo settings. 
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Creating the automation involved a lot of 
trial-and-error. Often I wanted to grab just 
a piece of a word, and also, it needed to 
fade out fairly fast; too much feedback 
would be problematic.  
 
Using a technique like this can be very 
intrusive, so I had to be careful. 
Sometimes only a couple dB of send level 
made the difference between something 
that worked, and echo that was 
overbearing. Refer to the screen shot 
below; the peaks in the purple line 
indicate where signal was sent into the 
Sonitus echo. 
 
The orange clips are even more 

interesting, because these involved changing the actual flow of the song itself. The first orange 
clip had a single drum hit that segued directly in the next part of the song. I felt a bit of a 
dramatic pause was in order, so I split at the hit’s beginning and end, bounced it to itself so 
there wasn’t anything after the hit, extended it (creating silence in the process), normalized to 
obtain the highest possible level, and then added the Sonitus reverb as a Clip effect. I thought 
this added an element of surprise that would keep listeners interested.  
 

 
The green clip simply normalizes the section coming out of the verse to give a little better lead-
in to the song’s next section. 
 
Finally, I added an organ part to re-inforce the existing, sustained one with phrasing that would 
be more like a horn section “sting” to emphasize the chord structure in the final chorus. Again 
because this was taking a chance with the artist’s vision, I kept it fairly low. 
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Even though the song had a mix that I liked, I felt some changes to the song itself were in order. 
That’s what takes this from being less of a mastering job—all it really needed was more 
midrange, and some dynamics processing—to more of a remix. Although there weren’t a lot of 
changes, I felt the ones that were there enhanced the song’s flow.  
 
Go to Cakewalk’s YouTube channel to see a video that compares the original and mastered 
versions. To make for a fair comparison, I’ve matched the peak levels of the “before” and 
“after” sections.  

https://www.youtube.com/CakewalkSoftware
https://youtu.be/nmLkv1yNQ2s
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Cakewalk 30th Anniversary Celebration: 

 30th Anniversary Rapture Expansion Pack 

By Craig Anderton 
 
 

This expansion pack started with sampling every note 
on a Gibson Midtown guitar, with individual samples 
for the bridge, neck, and both pickup positions. But 
as so often happens, things got out of hand. Of 
course you can play traditional guitar sounds with 
this pack, however there are also 12-string sounds 
that are quite useful—even though there’s no 

physical 12-string Midtown guitar. And for the six-string guitars, there’s “faux feedback” that’s 
lots of fun. You’ll even find octave above and suboctave components added to some of the 
guitars. There are also synth-type sounds, world sounds, clean leads, basses, and more. They all 
have unique sonic qualities because of their genesis as guitar samples. 
 
The programs 
have some 
elements in 
common. All 
programs except 
for the Big Synth 
Organ program 
have Bass and 
Treble tone 
controls. The X/Y 
Pad 1 X-Axis 
controls 
Modulation 
Depth, and the Y-
Axis controls 
Modulation Frequency.  
 
The Mod wheel (Continuous Controller #1) is unassigned because you might want to use “MIDI 
Learn” so the mod wheel can control an expression parameter on the Instrument page, but it’s 
easy to assign the X/Y Pad X-Axis to the modulation wheel. Right-click on the X/Y Pad crosshair, 
choose “X MIDI Forget” if the X-Axis is already assigned, then choose “MIDI Learn” and rotate 
the mod wheel. It will now control the X/Y Pad 1 X-Axis in all programs.  
 
Oh, and one final tip: Try the guitars through amp sims or the CA-X amps. Tasty! 
 
  More online! Listen to a 2-minute audio/video demo of ten of the 
  expansion pack programs 
 

https://youtu.be/s9ue1ZRGOKo
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12-STRING MIDTOWN (BRIDGE, NECK+BRIDGE, AND NECK) 
 

All three 12-string programs have the same Instrument page controls. Although there is no 
physical Midtown 12-string guitar, we can have a virtual one! These programs use SFZ file 
coding to stack two sampled strings an octave apart over the typical 12-string range where you 
hear octave strings (up to B5), then starting at C5 doubles the higher strings where octaves 
aren’t possible (just like a real 12-string guitar).  
 

¶ Fifth Above adds a virtual string a fifth above the tonic string.  

¶ Suboctave adds a virtual string an octave below the tonic string. 

¶ Hex Fuzz applies distortion to each string independently. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect.  
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6-STRING MIDTOWN (BRIDGE, NECK+BRIDGE, AND NECK) 
 

These programs are straight-ahead Midtown guitar samples, but there are still a few tricks. All 
three have four additional voices—one to provide an octave up virtual string, one for a 
suboctave virtual string, and two sine waves to emulate the sound of feedback being created as 
the note sustains. This really comes into its own when running any of these presets through a 
CA-X amp with distortion, like the Hard Rock amp (as you can hear on the demo video).  All 
three programs (Bridge, Neck+Bridge, and Neck) have the same control complement. 
 

 

¶ + Octave Higher adds a virtual octave-above string.  

¶ Suboctave adds a virtual suboctave string. 

¶ Feedback adjusts the level of the virtual feedback, which fades in as you hold the note. 

¶ Tremolo Depth controls the range of the amplitude  changes caused by the  

¶ non-tempo-synched tremolo effect. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect.  

 
 
  

https://youtu.be/s9ue1ZRGOKo
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BASS (8-STRING AND BRIDGE) 
 

Dropping the Midtown strings down an octave creates useful bass sounds. The Bass 8-String 
uses the same type of SFZ coding as the 12-string guitars to synthesize the sound of an 8-string 
bass, while the Bass Bridge program has the characteristic sound of a bass’s bridge pickup. Both 
have the same control complement; the AutoWah provides a slow, rhythmic wah pedal effect. 
 

¶ Filter Resonance and Filter Cutoff control a four-pole filter. Try turning up the 

Resonance control, and map the Filter Cutoff to a hardware controller. This provides 

useful wah-type effects. 

¶ Suboctave adds a virtual suboctave string. 

¶ Edge gives a gritty, dirty, amp-type sound. 

¶ AutoWah Range increases the AutoWah effect’s depth. 

¶ AutoWah Rez sets the resonance for the AutoWah effect. 
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BASS NECK 
 
Here’s another bass sound, this time using the smooth sound of the neck pickup. The 
Instrument page controls are somewhat different from the other basses.  

 
¶ + Octave Higher adds a virtual octave above string.  

¶ Suboctave adds a virtual suboctave string. 

¶ Tone Control gives the effect of the tone control on a bass, but with a slightly steeper 

slope than standard tone controls (two-pole instead of the single-pole passive tone 

controls found in most basses). 

¶ Edge gives a gritty, dirty, amp-type sound. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect. This can be useful in jazz 

bass applications. 
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MINOR = MAJOR 
 

Minor = Major is a variation on the six-string guitar programs, and also includes virtual 
feedback. However, this program includes an extra voice to provide either a major third or 
minor third harmony. Here’s what the controls do. 
 
 

 

¶ Harmony Level controls the harmony’s level. 

¶ Minor/Major  chooses the minor third harmony when fully counter-clockwise; turning 

this control clockwise ends up at the major harmony.  

¶ Feedback adjusts the virtual feedback’s level, which fades in as you hold the note. 

¶ Tremolo Depth controls the range of amplitude changes caused by the non-tempo-

synched tremolo effect. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect.  
 

You can alter the harmony and interval controlled by the Minor/Major control easily. Element 
2’s Pitch Transposition sets the initial harmony, and the Pitch 2 limit that’s assigned to Macro 
Knob 4 in the Mod Matrix sets the interval. With Macro Knob 4’s amount parameter, adding 
100 raises the pitch by one semitone.  
 
For example, suppose you want the Minor/Major control to vary between a major third and 
fifth. Set Element 2’s Pitch Transposition to 4 (a major third). For Macro Knob 4 to transpose up 
a fifth, it needs to go three semitones higher than the initial harmony, so you’d set the Macro 
Knob 4 amount in the Mod Matrix to 300.  
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POWER CHORD 
 
Here’s another program that really comes into its own when used with the CA-X amp sims (or 
other amp sims, for that matter). It combines the original string pitch with virtual strings a fifth 
and octave above, but if you want even more of a power chord feel, you can add another 
virtual string that produces a suboctave. Like several of the other guitar programs, you can mix 
in “faux feedback.” After all—it’s a power chord, right? 
 

¶ Add Fifth+Octave mixes in the fifth and octave that create the power chord. 

¶ Suboctave adds an octave-below virtual string to round out the bottom and add more 

power to the overall sound.  

¶ Feedback adjusts the level of the virtual feedback, which fades in as you hold the note. 

¶ Tremolo Depth controls the range of amplitude changes caused by the non-synched 

tremolo effect. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect.  
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GUITAR BRIDGE HEX FUZZ 
 

This optimizes the hex fuzz sound for the guitar bridge pickup, but when you kick in the octave 
higher component and suboctave, the result is kind of like a punk pipe organ. The program 
defaults to this setting, so sit back and enjoy a big, powerful, guitar-based sound that ends up 
being more like a huge synth/keyboard. 
 

¶ + Octave Higher adds a virtual octave-above string.  

¶ Suboctave adds a virtual suboctave string. 

¶ Hex Fuzz controls the amount of distortion. Each string has dual distortion (DSP2 and 

DSP3) except for the Suboctave, which uses only a single distortion stage. 

¶ Tremolo Depth controls the range of volume changes caused by the  

¶ non-tempo-synched tremolo effect. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect.  
 
 

Bonus Tip! Try using the Rotating 
Speaker FX from the 2017.06 30th 
Anniversary FX Chains, with the 
settings shown. It adds another 
dimension to the “organ” sound.  
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GUITAR BRIGHT AND HARD 
 

Try this program when you want an alternative to rock piano samples. You’ll have the same 
kind of percussive attack, and similar decay characteristics. Using the virtual 12-string samples 
provides the extra touch of brightness from having the octave strings in the mix. For an even 
brighter sound, turn up the Edge control to create more harmonics and add some “bite” to the 
sound.  
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff can dial in the desired amount of brightness, and is particularly useful for 

trimming the amount of brightness added by the Edge control. 

¶ Tremolo Rate controls the amp tremolo speed. It’s not synched to tempo, so if you want 

tempo sync, you’ll need to turn on Sync in the Amp’s LFO/KEYB tab for Elements 1 and 

2.  

¶ Tremolo Depth controls the range of volume changes caused by the tremolo effect. 

¶ Edge adds distortion and brightness.  

¶ Reverb Mix controls the amount of reverb mixed into the sound. 
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GUITAR MUTED BRIDGE 
 

Palm muting with guitar creates a percussive sound, and it’s good for a lot more than Bob 
Marley-type reggae strumming. This program implements more Chorus controls than other 
programs, which offers added flexibility when using a chorus effect. For example, if you turn 
down Chorus Rate and Chorus Depth, turning up Chorus Feedback and Chorus Mix gives a 
metallic effect not unlike “bathtub reverb.” 
 

 
¶ Edge accents the timbre’s intensity. The distortion isn’t quite as much as some of the 

other programs, but it does add a useful edge. 

¶ Tremolo Depth controls the range of volume changes caused by the non-tempo-

synched tremolo effect. 

¶ Chorus Feedback, Chorus Rate, Chorus Depth, and Chorus Mix provide the same 

controls as typical chorus effects.  
 
 
 

Bonus Tip! The Slow Roll Phaser 6 FX Chain from the 2017.06 30th Anniversary FX Chains 
complements the muted bridge 
sound well.  
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GUITAR NECK HEX FUZZ 
 

This is basically a “kinder, gentler” version of the Guitar Bridge Hex Fuzz, and includes the same 
complement of controls. The distortion has a bit more of an “amp” sound, and isn’t as bright as 
the Guitar Bridge Hex Fuzz. 
 

 
¶ + Octave Higher adds a virtual octave-above string.  

¶ Suboctave adds a virtual suboctave string. 

¶ Hex Fuzz controls the amount of distortion. Each string has dual distortion (DSP2 and 

DSP3) except for the Suboctave, which uses only a single distortion stage. 

¶ Tremolo Depth controls the range of volume changes caused by the  

¶ non-tempo-synched tremolo effect. 

¶ Chorus Rate and Chorus Depth emulate a typical chorus effect.  
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GUITAR PIANITAR 
 

No, it doesn’t sound like an acoustic piano…but it feels like it has something in common with 
electric and electronic pianos, so you can think of this program as a variation on keyboard synth 
sounds. Two 12-string samples form the basis of this sound.  
 
In terms of processing, the Chorus capabilities are deep enough to give convincing chorus 
effects, and the tremolo depth synchronizes to SONAR’s tempo.  
 

¶ Edge adds some brightness and color to the basic sound.  

¶ Filter Cutoff allows more sophisticated tone control that what’s available with just the 

Bass and Treble controls. Try controlling Filter Cutoff with a footpedal or other hardware 

controller. 

¶ TremSync Depth controls the range of volume changes caused by the tempo-synched 

tremolo effect. To select a different sync rate, choose the Amp > LFO/KEYB parameter 

for each Element, and change the Sync rate from the drop-down menu. 

¶ Chorus Rate, Chorus Depth, and Chorus Mix provide the controls for a typical outboard 

chorus effect. 
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GUITAR STEEL+PEDAL 
 

With proper playing technique, this program does a pretty convincing steel guitar sound. In 
particular the vibrato can fade in, so if you use pitch bend to slide up to a tone, the vibrato 
appears naturally in the same way that it usually does with steel guitar. The X/Y Pad 1 X-Axis 
controls the vibrato frequency and depth; however, please note that you can’t use it to add 
vibrato independently of the fadein. 
 
What really helps in creating a realistic emulation is how you work the pitch bend control. With 
chords, sliding up to the ending pitch is a common technique, while for single notes, bending 
down and up to notes is a popular technique for soloing. Also, many steel guitar players use a 
volume pedal to add attacks to notes. 
 

¶ Edge imparts more of an “amp sound” to your virtual steel guitar.  

¶ Filter Cutoff allows more sophisticated tone control that what’s available with just the 

Bass and Treble controls. Controlling it with a foot pedal can provide a useful wah effect. 

¶ Vibrato Fade In controls how long it takes for vibrato to appear after hitting a note.  

¶ Chorus Rate, Chorus Depth, and Chorus Mix provide the controls for a typical outboard 

chorus effect. 
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LEAD CLEAN 
 

There are plenty of lead sounds that can cut through a track—this one is a bit more “chill,” and 
designed more to “float” on top of the track. The Reverb and Delay controls have a lot to do 
with this, but so does the timbre and the way you introduce vibrato. 
 
Auto Vibrato increases both vibrato depth and vibrato fade-in time simultaneously as you turn 
it clockwise. It also interacts with X/Y Pad 1, which sets the maximum amount of vibrato depth, 
as well as the vibrato frequency. Tremolo also has an unusual implementation. Element 2’s 
tremolo syncs to tempo, while Trem Syncopate controls the speed of Element 1’s tremolo. 
 

¶ Trem Depth controls the range of volume changes caused by both the Element 1 and 

Element 2 tremolos.  

¶ Trem Syncopate sets the speed of Element 1’s tremolo, which provides syncopation 

because Element 2’s tremolo frequency stays locked to tempo.  

¶ Delay Feedback controls the number of repeats for the built-in delay line. 

¶ Delay Mix determines the balanced of delayed and dry sound. 

¶ Reverb Mix controls the amount of reverb mixed into the sound. 
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LEAD HARD SYNC 
 

Maybe guitars can’t do hard sync…but they can in virtual instrument-land. Unlike the Lead 
Clean program, this one is aggressive and can definitely cut through a track. The program 
emulates a synth’s hard sync sound by passing a sound with resonant filtering through 
distortion (in this case, DSP1’s “Tube” algorithm). There are also three ways to control the hard 
sync frequency (Manual, Step Generator, and LFO); note that all three are available 
simultaneously, and can interact with each other.  
 

 

¶ Fundamental increases the level for Element 3, which is simply the unprocessed 

neck+bridge pickup samples—it’s not subject to the hard sync effect. Emphasizing the 

fundamental can give more “girth” to the normally thin hard sync timbre. 

¶ {ȅƴŎ άIŀǊŘƴŜǎǎέ determines the hard sync effect’s tonal character. Turning this control 

counter-clockwise sounds more like “hard sync meets filtering,” while clockwise gives 

the more traditional hard sync sound.  

¶ Manual Ctrl alters the hard sync frequency. To have Manual exert the greatest influence 

over the hard sync frequency, turn down the StepGen Ctrl and LFO Ctrl parameters. 

¶ StepGen Ctrl introduces step-generated modulation to the hard sync frequency, with 

the lowest frequency set by the Manual control. 

¶ LFO Ctrl varies the hard sync frequency based on the LFO frequency. 

¶ LFO Rate sets the LFO frequency. 
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LEAD SYNTH 
 

Unlike the Lead Clean preset, this one is designed to stand out in a mix. It also has just enough 
attack time to add a bit of a “bowed” vibe, although with just a hint of hard sync-type 
harmonics.  
 
Tremolo Rate and Tremolo Depth do what you’d expect, but Step Gen—which modulates the 
filter—uses a trick I’ve found handy on many programs. The filter defaults to being up all the 
way, so that with the Step Gen control down, there’s no effect. When you turn up Step Gen, it 
applies a negative amount of modulation, which makes the effect more apparent by lowering 
the filter cutoff. 
 

 
¶ Tremolo Rate controls the amp tremolo speed. It’s not synched to tempo, so if you want 

tempo sync, you’ll need to turn on Sync in the Amp’s LFO/KEYB tab for Element 1.  

¶ Tremolo Depth controls the range of volume changes caused by the tremolo effect. 

¶ Step Gen applies step modulation to one of the program’s filters.  

¶ Harmonic Control does timbral variations by simultaneously altering the DSP distortion, 

filter cutoff, filter resonance, and volume (to compensate for level changes when the 

other parameters change). 

¶ Delay Feedback controls the number of repeats for the built-in delay line.  

¶ Delay Mix determines the balanced of delayed and dry sound. 
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RHYTHMIC HEAVY PATTERNS 
 
One of Rapture’s major strengths is extensive modulation capabilities, so three programs in this 
30th Anniversary Celebration take advantage of step-generated modulation. Although these 
programs have nothing to do with traditional guitar sounds, they provide interesting electronic 
sounds based on the organic sounds of the Midtown guitar. Use them as textures mixed behind 
a rhythm track, as breaks in a conventional song, as part of the rhythm for EDM, and the like. 
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff adjusts the initial frequency to which the Step Generator adds modulation. 

¶ Filt StepGen Depth applies step-generated modulation to the two Elements, whose step 

sequencers are set independently. This control interacts with Filter Cutoff; for example, 

with Filter Cutoff fully counter-clockwise, applying modulation will have the greatest 

effect and cover the widest range.  

¶ Width sets the stereo separation of the two Elements. Fully clockwise gives maximum 

stereo separation.  

¶ Edge adds the ever-popular combination of distortion and brightness. 

¶ Reverb Mix controls the amount of reverb mixed into the sound. 
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RHYTHMIC STEPPED POWERCHORD 
 

In this step sequencing-based program, the actual effect itself is fixed but what it affects is not. 
The basic effect consists of a single Element, but two addition Elements provide one voice an 
octave below, and one voice a fifth above, to create a step-sequenced power chord. As with the 
previous program, the step sequencing affects filter cutoff. 
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff sets the initial frequency to which the Step Generator adds modulation. 

¶ Xtra Voices controls the level of the octave-below and fifth-above Elements.  

¶ Xtra Voices Width sets the stereo separation of the two extra voice Elements. Fully 

clockwise gives maximum stereo separation.  

¶ Edge adds an edgy combination of distortion and brightness. 

¶ Reverb Mix controls the amount of reverb mixed into the sound. 
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RHYTHMIC TENSION 
 

Step lively…this sounds somewhat like marching synthesizers that add a feeling of tension, or 
lumbering, depending on your point of view. This program can add a useful backdrop to solos, 
and textures to dance music (particularly electro). The actual step-sequencing effect isn’t 
editable from the front-panel controls, but there’s quite a bit of leeway in how you can process 
the sound. In particular, turning up the delay line feedback can augment the “stepping” sense 
imparted to the filter. 
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff sets the initial frequency to which the Step Generator adds modulation. 

¶ Edge adds an edgy combination of distortion and brightness. 

¶ Width increases the apparent stereo width.  

¶ Delay Feedback determines the number of repeats generated by the delay line. 

¶ Delay Mix sets how much delayed signal gets mixed into the sound. 
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SYNTH BIG ORGAN 
 

With guitar-based sounds that aren’t looped, you can’t do true organ sounds that sustain 
forever. So, this program is more like a cross between an organ sound and a polysynth. It can 
provide a textured, big background behind leads or percussion, or even do some stabs at 
strategic moments. 
 

 

¶ Tone is a “morphing” tone control that goes from full bass when counter-clockwise to 

full treble when clockwise. 

¶ Emphasis adds a subtle lift to the overall sound. 

¶ Step Gen Smooth changes the shape of the step-generated modulation by rounding off 

the “corners” of the steps.  

¶ Step Gen Depth applies step-generated filter modulation to add animation and interest.  

¶ TremSync Depth controls the range of volume changes caused by the tempo-synched 

tremolo effect. To choose a different sync rate, choose the Amp > LFO/KEYB parameter 

for each Element, and change the Sync rate from the drop-down menu. 

¶ Edge adds a taste of distortion and brightness. 

¶ Chorus Depth and Chorus Mix provide the sound associated with outboard chorus 

effects. 
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SYNTH CHOIR PAD 
 

What if you had a bunch of female singing guitars that wanted to sound like a choir? It might 
sound a little like this. The vibrato can fade in over time. The X/Y Pad 1 X-Axis controls the 
vibrato frequency and depth; however, you can’t use it to add vibrato independently of the 
fadein. 
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff dials in the desired amount of brightness. 

¶ Vibrato Fade In controls how long it takes for vibrato to appear after hitting a note.  

¶ Attack smooths the attack time. When fully counter-clockwise, there’s an almost brass-

like “blip” that occurs at the beginning. 

¶ Release determines how long it takes for the audio to fade out after you release your 

fingers from the keys. 

¶ FX Modulation applies a fixed chorus effect to give some animation to the “pseudo-

choir” sound. 
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SYNTH ELECTRIC PIANO 
 

This program has a surprising number of different ways to “shade” the basic sound. For 
example after the program loads, play with the Tremolo Depth, turn Filter Tone fully clockwise, 
and turn up Filter Resonance—now you have more of a clav-type sound, and varying Edge adds 
quite a bit of tonal variation. If you want to go more toward the electric piano end of the 
spectrum, don’t forget the tremolo. 
 

 
 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff. Because it 

precedes distortion, turning up resonance can give a bit of a hard sync effect. 

¶ Filter Tone dials in the frequency for a 2-pole highpass filter. 

¶ Edge alters the timbre by adding distortion and overlaying some brightness. 

¶ Tremolo Rate controls the amp tremolo speed. It’s not synched to tempo, so if you want 

tempo sync, you’ll need to turn on Sync in the Amp’s LFO/KEYB tab for both Elements 1 

and 2.  

¶ Tremolo Depth controls the range of volume changes caused by the tremolo effect. 

¶ Reverb Mix controls the amount of reverb mixed into the sound. 
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SYNTH PEACEFUL FILTER 
 

This is a sweet kind of pad that would have been perfect back in the days when “new age” 
music was hot. Although you’ll find a step generator controlling a filter, unlike some of the 
previous programs the default sound applies this fairly conservatively. Of course, you can 
always make it as radical as you want.  
 

 
¶ Step Gen Smooth changes the shape of the step-generated modulation applied to a 

filter by rounding off the “corners” of the steps. This should be the first control you 

tweak when you want to make the sound more peaceful. 

¶ Step Gen Depth applies step-generated filter modulation to add animation and interest.  

¶ Poly Fuzz adds distortion in a way that’s more about changing the audio waveform than 

creating a hotter, more distorted sound. 

¶ Attack smooths the attack time. 

¶ Release determines how long it takes for the audio to fade out after you release your 

fingers from the keys. 

¶ FX Modulation applies a fixed chorus effect to give some animation to the pad sound. 
  



 
 

62 

 

SYNTH SHARP+GENTLE 
 

When you want a guitar sound with a keyboard feel, try this program. It has a gentle overall 
vibe, but with a guitar attack that adds some character and definition to the sound. It’s a pretty 
versatile program—it works for a clean lead sound as well as background chords with a little bit 
of “bite” to them.  
 

 
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff dials in the desired amount of brightness. 

¶ Detune adds a natural chorusing sound when turned clockwise. 

¶ Width alters the stereo image, but in a subtle way. Full clockwise widens the image 

somewhat, but also allows the program to sit back further in a track.  

¶ Chorus Depth controls the depth of the chorus, which has a fixed, slow frequency. 

¶ Chorus Mix sets how much of the chorused sound is mixed in with the unprocessed 

audio.  
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WORLD SITAR+DRONE 
 

This is a pretty cool patch…too bad it was born about half a century too late to be part of the 
psychedelic sixties, when the Beatles introduced the sitar to rock music. My favorite part about 
this program is that you can play a sitar lead, with pitch bending, while the drone in the 
background stays at a constant pitch that’s set by the Drone Transpose control. This is also the 
only program that uses up all 24 slots in the Mod Matrix. 
 

 

¶ Drone Transpose determines the pitch of the drones (C to C octave higher). The pitch 

does not change when you play different keys on the keyboard. 

¶ Drone Level sets the level of the drones in relation to the sitar sound itself. 

¶ Drone FX Mix dials in the amount of chorusing mixed in with the drones. 

¶ Sitar Timbre changes the sitar tone’s “bridge buzziness.”  

¶ Drone Timbre uses distortion to change the drone waveform. Turn it counter-clockwise 

for the most “mellow” sound. 

¶ Reverb Mix controls the amount of reverb mixed into the sound. 
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WORLD TAMBURA 
 

The drone sound in the World Sitar+Drone program is relatively inflexible, because the drone is 
there to serve the main sitar sound. But the drone sound is too good to relegate to a supporting 
role, so this program removes the sitar sound and lets the drone sound (based loosely on the 
Indian tambura) really shine. 
 
 

 

¶ Filter Resonance increases the Q at the filter frequency set by Filter Cutoff.  

¶ Filter Cutoff dials in the desired amount of brightness. 

¶ Auto-Pan this isn’t particularly obvious…it just adds some motion to two of the 

Elements to make for a more animated overall sound. 

¶ Drone Transpose determines the pitch of the drones (C to C octave higher). Unlike the 

Sitar+Drone program, the drone pitch does change as you play the keyboard, so this 

control comes in handy more for real-time octave jumps. 

¶ Drone Timbre uses distortion to change the drone waveform. Turn it counter-clockwise 

for the most “mellow” sound. 

¶ Drone FX Mix controls the mix of reverb and chorus added to some of the Elements. 
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